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Introduction

&~ |Dear Valued GeoSIG Customer, thank you for purchasing this product.

These Instruments have been optimised to meet the requirements of the majority of customers
out of the box and may have even be delivered tailored to your needs. In any case, to be able
fo get the most out of our product, please carefully study this manual, its appendices and
referenced manuals, as well as any other documents delivered with it.

This is a reliable and easy to use device, and at the same time a sophisticated product, which
requires care, attention and know-how in configuring, installing, operating and maintenance.

Warnings and Safety

The Shaking Table should be operated by trained people only.
Ignoring the warnings in this manual can destroy the Shaking
Table or even lead to serious injury or loss of life.

The Shaking Table must be properly fixated on the floor, against
a wall or any other strong structure.

Always turn off the Shaking Table with the Emergency Stop
Button before going closer than 1 meter. The Emergency Stop
Button must be easily reachable by the operator at any time.

Make sure that the Shaking Table stands clear from any objects
by minimum 1 meter. The working space of the controller must be
away from the Shaking Table by minimum 1.5 meter

IZ~ | Do not put credit cards, mobile phones or any electronic devices close to the magnet.

&~ |Do not plug in any cable to the computer or the Shaking Table before carefully studying
this manual. Drivers must be installed before connecting the USB-to-CAN-Converter



Page 6/38

GS_GSK-166_

Shaker_UserManual_V08.doc/18.11.2014
GSK-188 Shaking Table User Manual

1. Hardware Setup

1.1. Cabling Overview

Power Input

230 VAC /50 Hz
Power Distribution
Box
— 230 VAC
- 24 VDC
/
Q/ DC
Sensor Output
N
'S I

Sensor Interface
+/-5 V (Single Ended)

‘ Computer
UsB
RS-232
(opfional) | USB-to-GAN
CAN
Emergency Itop

‘ Linear motor

Accelerometer

Figure 1. Cabling overview
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1.2. Power Distribution Box

The Shaking Table needs 230 VAC for operation. Connect a cable with Phase (Brown), Neutral (Blue) and
Protection GND (Yellow/Green) to the terminal block on the right side. The cables are connected by clamps,
not by screws. Therefore simply push with a small screwdriver (No 00) in the hole as shown in the right
bottom picture of Figure 2 to release the existing cables or mount new ones.

buts to reference sensor
and Xenus controller

IAC Input

1.3. Xenus Controller

Figure 2, Power Distribution Box

All cables to and from the Xenus controller are already pre-manufactured and installed. Therefore no
modifications are needed for the start-up of the Shaking Table.

Connector J1 - 230 VAC

4

3
2
1

Connector J2 — Motor Output

4

3
2
1

Connector J4 - 24 VDC

3
2
1

Main Input L3
Protective Ground
Main Input L2
Main Input L1

Motor Phase U
Motor Phase V
Motor Phase W
Cable Shield

+24 VDC
n/c
GND




Ge?SIG |

Page 8/38

GS_GSK-166_Shaker_UserManual_V08.doc / 18.11.2014

GSK-188 Shaking Table User Manual

Connector J5 — RS-232
n/c

TxD Output

GND

GND

RxD Input

n/c

NP OOTO

Connector J6 — Can Bus

The upper connector is connected the
termination adapter

The lower connector is connected to
the USB-to-CAN converter

Connector J7 — Emergency Stop
This connector is wused for the
emergency stop.

Table is disabled if the
emergency stop button is not

£~ |For your safety the Shaking
connected.

2. Installation of the Drivers and Software

2.1. Drivers

ETATUE

&~ |Keep your USB-to-CAN converter unplugged until you have installed all the driver and software

2.1.1. USB to CAN

To be able to use the shaker, the first thing is to install the drivers. If you use the standard delivered
converter (USB-to-CAN compact from IXXAT) you should install the VCI 2.16. This driver you can find on the
CD provided by GeoSIG, if you don’t have this CD, please contact GeoSIG. Please run the application
named vci216+sp2.exe in the folder Soffware And_Drivers and follow the instructions of the setup, then
restart your computer. If there are any problems, contact GeoSIG or use the manual from the provided

GeoSIG CD under Manuals_And_Guides\vci31_Users_Guide.pdf
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Lo

Welcome to the IXXAT VCI V2.16
+ SP2 Setup Wizard

“This wilinstall XXAT VCI V2.16 + SP2 on your computer.

you close
continuing.

Cick Next to cortinue, or Cancsl to ext Setup.

x|

Ready to Install N
Setup i now ready o begin instaling DXXAT VC1 V2.16 + SP20n your computer. i

Ciick Instal click ot
change any settings

[Destnation location
C:\Program Fles\DOATVCI 2.16

e[ D el

x|

x|

Select Destination Location N
Where shoud [XXAT VCI V2.16 + SP2be installed? QU

J IXGAT VCI V2,16 +

To continue, cick Next. ¥ you would ike to select a diferent folder, lick Browse.
\Program Fles\XOAT\VC 2,16} Bpowse.

Atleast 63 MB of free disk space is required

<aoo( T o> D s

2.1.2. CMO (GeoDAS Communication Driver)

x|

Information . ’;@

When you are ready to continue with Setup, cick Next

[This CD contains:

Lo

Completing the IXXAT VCI V2.16
+ SP2 Setup Wizard

T&=D

To be able to use the shaker with GeoDAS, the CMO driver must be installed. Please install the driver from
the provided GeoSIG CD by unpacking the file CMO.zip in the folder Software And Drivers and run

Setup.exe.
=loixd

Welcome to the CMO 2.18 Setup
Wizard

nof MO

d wil uide you throu

Ciick Next to continue,

s )] ) cencel

Completing the CMO 2.18 Setup
Wizard

2.2. Software

2.2.1. CME2

License Agreement =y
Blesse review the icense terms before instaling CMO 2,13, g 1

Bress Page Do to see the rest of the sgreement

el o ] o

Choose Install Location =
Choose the folder n which to install CMO 2,18, iy

. cick Browse

» MO 2.18 n the folon 5
‘2nd select another folder. Cick Insta to start the nstaliaton,

Space required: 5.0M8
Space avalable: 35.565

<2l rea D e

CME?2 is the software used to change the settings of the motor and its controller. Please install the software
from the provided GeoSIG CD by unpacking the file CMEZ2.zip in the folder Software_And_Drivers and run
Setup.exe. Alternatively you can download the latest version here: http://www.copleycontrols.com/

Motion/Downloads/index.html
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Welcome to the CME 2 V6.0 Setup
Wizard

=loix|

Completing the CME 2 V6.0 Setup
Wizard

2.2.2. GeoDAS

GeoDAS is the GeoSIG software which is used to control the movement of the shaking table. Please install
GeoDAS from the provided CD or download the latest version from here: http://www.geosig.com/Downloads-
pg66.html. For details about all its functions please consult the GeoDAS User Manual.

2.3. Example Data

Please copy all demo scripts from the provided CD to your computer. To do this please unpack the file
Examples.zip in the folder Examples on the CD to the folder C:\GeoDAS_DATA\Tester

2.4. First Connection

2.4.1. USB to CAN Installation

If you have installed all the drivers and software from the previous chapter, restart your computer and plug in
all the power cables of the shaker.

As soon as the computer is restarted plug in the USB cable of the USB-to-CAN converter into one of your
USB ports. Now Windows should ask you to install the driver.

ound New Hardware Wizard

Fi

Welcome to the Found New
Q“Q\ Hardware Wizard
Windows will search for current and updated software by

looking on your computer, on the hardware installation CD, or on
the Windows Update Web site [with your permission).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

" Yes, this time only

" Yes, now and every time | connect a device

Click Next to continue.

q Next > P Cancel |

Figure 3, USB-to-CAN driver installation, step 1

e Select No, not this time
* Press Next >
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Now you'll be asked if the computer should search automatically for the driver.

» Select Install from a list or specific location (Advanced)
* Press Next >

Hardware Update Wizard

5 This wizard helps you install software for:

VCI3 USE-to-CAN compact

* ) If your hardware came with an installation CD
~4~ o1 floppy disk. insert it now.

What do you want the wizard to do?

C Ins sis-ariematisaliBecommended)
& instal frome..'.iﬁ!..9!..§9§.9ﬁ!i9._'9.99.!!99..lAdvancedD

Click Next to continue.

< Back q Next > P Cancel |

Figure 4, step 2

The following window will appear.

e Select Don’t search. I will choose the driver to install
* Press Next >

[ Hardware Update Wizard 1

Please choose your search and installation options. ‘\

&

(" Search for the best driver in these locations.

Use the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

™ Include this location in the search

< Don't search. | will chaose the driver lo@

Choose this option to select the device driver from a list. “Windows does not guarantee that
the driver you choose will be the best match for your hardware.

< Back 4 Next > b Cancel

Figure 5, step 3

* Select IXXAT USB-to-CAN compact
* Press Next >
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Hardware Update Wizard E

Select the device driver you want to install for this hardware. N
&

Fe8) Select the manufacturer and model of your hardware device and then click Next. If you
have a disk that contains the driver you want to install, click Have Disk.

[V Show compatible hardware

7 A This driver is not digitally signed! Have Disk...

Tell me why driver signing is important
<8ackq Next > I) Cancel |

Figure 6, step 4 — Select the driver IXXAT USB-to-CAN compact

Found New Hardware Wizard B

Please wait while the wizard installs the software...

Eﬁl VCI3 USB-to-CAN compact

Setting a system restore point and backing up old files in
case your system needs to be restored in the future.

Figure 7, step 5

Completing the Found New
Hardware Wizard

The wizard has finished installing th

Eﬁmi IXXAT USB+o-CAN compact

Click Finish to close the wizard.

Figure 8, step 6

* Press Finish, then close the window and restart your computer
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2.5. CME2
Switch on the shaker by connecting it to the power.

&~ |Make sure that the Emergency Stop button is pressed!

Open the CME2 Software from your Start menu. When the program is opened, you have to confirm the
following message

* Press OK

F12 Drables Ampiher x

The F12 key functions as an Amplifier Disable key when CME 2 is running,
connected to the amplifier, and is the active application.

D

Figure 9, Confirm this message

The program will then search any connected shaker controller. Wait until the CAN port is found

< i =10l x|

[Eil»ei Amplifier  Tools Help
i B E E|

—® Copley Neighborhood

£

Scanning for Copley amplifiers on the CAN network.

Scanning Node:

Found:

| [
Figure 10, CMEZ2 is scanning for a CAN network

If the shaker is not found (normally on the first start) please do the following steps

* Open Tools > Communication Wizards
* Select CAN Network and press Next >
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I

=1oix]

File Ampiifier Tools hl‘j‘cb

B vitual Amplifier

Figure 11, Select CAN Network

* Select a Bit Rate of 500kbit/s, then press Finish

Configure CAN Network

CAN Card: |IXXAT

Cancel |

Figure 12, CAN Network parameters

The following window will open, showing all the feedback loops of the amplifier

[ CME 2 v6.0 (XSL-230-18 GS_Shaker)
File Amplifier Tools Help

SN THEIEETT

14 Copley Neighborhood
Input / Output

|°—-RBVirtual Amplifier
CVM Control Program |

=10lx]

Regen Settings |

Configure Faults |

iS‘ne Commutation

]Linear Motor ’

o Di

| F12 To Disable |

Figure 13, Amplifier Settings

No adjustments need to be done here. The behaviour of the linear motor can be adjusted, but should only be
done after the CME2 User Manual is fully understood. The manual is provided on the delivered CD or here:

http://www.copleycontrols.com/Motion/Downloads/software.html.

(C-p

Adjustments of the amplifier settings should be done by trained people only. Wrong

settings can destroy the shaking table or even lead to serious injury or loss of life.
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3. Installation of the Shaking Table

3.1. Horizontal Operation
Make sure that the Shaking Table is levelled and properly fixated on the floor, against a wall or any other

strong structure. Otherwise no specific adjustments are necessary. Proceed directly with chapter 4, Start up
of Shaking Table.

3.2. Vertical Operation
If the shaker is vertically operated, the weight of the sliding carriage and the device under test must be

compensated to take the load from the motor. Additionally the compensation makes sure that the sliding
carriage will not fall down in case the motor will be disabled because of the emergency stop.

3.2.1. Material List

{4

5
il
B
!\‘
k.
i
iy
f.3

Figure 14, Material for vertical Shaking Table

Explanation:
1. Fixation Rope for Sliding Carriage 5. Guide Roller with Karabiner
2. Extension Rope 6. Threads, Nuts and Anchor Bolts
3. Elastic Bands 7. Double Guide Roller
4. Fixation Point for Roof 8. Fixations for vertical mounting
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3.2.2. Turning the Shaking Table

The Shaker can be turned from horizontally to vertically by
the following steps:

* Remove the four screws at the back of the
shaking table (see A1 in the Figure 15)

» Slightly loose the four screws on both sides of
the rotation axis (A2)

&~ |Hold the Shaker platform and the sliding
carriage when loosening the screws to
avoid any uncontrolled change from
horizontal to vertical.

* Move the platform from the horizontal to the
vertical position as shown in the Figure 15.

* Fixate the table again by tighten all screws on
the bottom of the movable part (A3, see also
Figure 14, Part 8) and the ones on both sides of
the rotation axis (A2)

* For the first installation, mark the position on the
roof (B) which is right above the linear motor
(Black block below the sliding carriage). This will
be used to mount the fixation point.

Figure 15, Vertically oriented Shaker

3.2.3. Fixation Point on the Roof

Mount the fixation point on the marked position right above the linear motor of the Shaking Table by using
the four provided screws and anchor bolts.

///W/AZ/W////

O' 'O

See
. See
Figure 12, Part 4 l l -------------------- Fig'u'fé 12, Part 6

|
i
Figure 16, Fixation Point on the Roof
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3.2.4. Fixation Point on the Sliding Carriage
A flexible rope is fixated around the linear motor block as shown in the figures below.

IE~ |Take care that no cables are in between the rope and the motor block. Push the rope
towards the platform as much as possible

See
Figure 14, Part 1

View from the top,
sliding carriage .-~

invisible

L= = = — = =

Figure 17, Fixation rope on the sliding carriage

U&"~ | This rope must be removed when the Shaking Table is used in horizontal configuration
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3.2.5. Mount the Compensation Rope

Now everything can be assembled together as shown in Figure 18. The number of Elastic Bands can be
adjusted depending on the weight of the device under test. For the empty sliding carriage including the
mounting angle normally two elastic bands are needed.

The length of the Extension Rope can be adjusted according to the roof height during the first installation.

Eixation Point for Roof
See Figure 12, Part4 & 6

“"““"D"OUb'e Guide Roller
See Figure 12, Part 7

Extension Rope

See Figure 12, Part 2 Guide Roller with Karabiner

See Figure 12, Part 5

Fixation Rope
See Figure 12, Part 1

Elastic Bands
See Figure 12, Part 3

Figure 18, Shaking Table setup for vertical operation

To mount the Extension Rope, following steps must be done (see Figure 19):

1. From the karabiner of the Extension Rope go up with the Fixation Rope to the Double Guide Roller
and down again.

2. Go with the Extension Rope through the Guide Roller with the Karabiner and up again through the
second Roll of the Double Guide Roller.

3. Cut the Extension Rope at the correct length and tie it on the karabiner.

&~ |The Extension Rope has the correct length when two Elastic Bands can hold the sliding
carriage in the middle of the Shaking Table without external help.
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Figure 19. Mounting of the extension rope

4. Start up of Shaking Table

If the shaker is installed, then the start up can be done as described in the following chapters.

i<

The following step-by-step procedure should be done first in the horizontal mode of the
Shaking Table.

* Please open GeoDAS and go to Tools > Multifunctional Tester

Ml Multifunctional Tester —ol

=10l x|

Test Command

Minimum

Maximum

Command | P2 | P3| P4 |PS(Message) [ Resut [ value [Comment |
Command 802 lADc Channels j
Options
Port == value |
Channels [D\F“EVE‘OUE" _:I

Message or a comment:

Insert [ Update | Signal Parameters.

mnal || meset | stopshaker [[f

Figure 20, Empty Multifunctional Tester window

* Make a right click in the white area and select Insert from File
» Select the file GS_Shaker_Demo_Homing.csv and press Open

Ml Multifunctional Tester —o (=] 9]
Test Command
[ 31 [ ep2 [ 3 [ P4 [Ps(message) Resut | val
Command 802  [ADC Channels | 1 ixxatd 500 kBit/s
Caution: Stand clear of Shaker
Options 330 1] 1000 Hardstop Negative
Port Value _5;3) .4 50 100
33 lome
Channels  [Differental |
Minimum Maximum
Message or  comment:
Insert I Update | Signal Parameters. |
Run Al | Reset | Stop Shaker | Quit |
< jii|

Figure 21, Multifunctional Tester window with loaded script

* Disable the Emergency Stop Button by turning the red knob.
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* Press Run All
* Make sure that nobody is within 1.5 m of the Shaking Table and confirm by OK

x|

o
l?) Caution: Stand clear of Shaker
<

Cancel ‘

Figure 22, Stand clear of Shaking Table

The Shaking Table will then define his zero position by moving slowly to one end and then fix the zero
position with an offset of 330 mm from this end.

View from top

(

-200 -100 0 +100 +200

Figure 23. Movement of GS_Shaker_Demo_Homing.csv

&~ | After the shaker has been switched off, the homing procedure must be repeated always
before applying any other movements.

(€

The homing procedure can not be done in vertical mode. Please referee to chapter 4.1
for details.

To get a feeling of the functionality of the shaker, several other examples are available on the provided CD.
When the Homing is finished and the Shaking Table stands still at its middle position, proceed with the
following steps.

* Make a right click in the command window, press Select All and then <Delete>.
* Make a right click again in the white area and select insert from file

* Select the file GS_Shaker_Demo_Move_Soft.csv and press Open

* Press Run All

The shaking table will first move to an absolute value of 100 mm, then go back to -100 mm and finally stop at
its zero position
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I
[}
E View from top
[}
|

-200 -100 0 +100 +200
Figure 24. Movement of GS_Shaker_Demo_Move _xxxx.csv

The script GS_Shaker_Demo_Move Hard.csv will do exactly the same movement, but much faster. Loading
the scipt GS_Shaker_Demo_Sweep.csv will create a sinus with a peak acceleration of 500 mg.

500 mg

View from top

-

-200 -100 0 +100 +200
Figure 25. Movement of GS_Shaker_Demo_ Sweep.csv

The script GS_Shaker_Demo_Earthquake.csv will simulate the movement of an earlier recorded earthquake
(X-channel)

View from top

-200 -100 0 +100 +200
Figure 26. Movement of GS_Shaker_Demo_Earthquake.csv
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4.1. Initial Homing in Vertical Operation Mode

In the vertical operation mode the Home of the Shaking Table must be set to zero always AFTER the device
under test has been installed on the sliding carriage. So therefore make sure that the device under test is
installed and adjust the number of Elastic Bands that the sliding carriage is approximately in the middle of
the Shaking Table. Then proceed with the following steps.

* Close GeoDAS and open the program CME2
* Click on the symbol Control panel

=T

File Amplifier Tools Help ) )
O «ul EEIEEFE L

(=} _§ Copley Neighborhood CAN Network:  Address: 1 State: Operational
1 viual Amplifier

1*~~BCAN1: unnamed Input / Output

[

CVM Control Program ]
CAN Configuration I—Q P Loop I—Q Y Loop l—} | Loop Motor/Feedback |

3

Home I Configure Regen Configure Faults |

'Siné Commutation [Lineaf Mator IAmp Under CAN Control f F12 To Disable

Figure 27, CME2 error

* Press Set Zero Position and make sure that the Actual Motor Position on the right side of the
window shows 0 mm

& Control Panel E =101 %]
Status Monitor
@ Motor Output: Not Active IActual Cusrent Z] - A
@ ¥ Hardware Enabled:  Enabled
# Software Enabled: Enabled
( by
& Positive Limit: Not Active Jactualpotor velocy ~ | IR s
! # Negative Limit: Mot Active

# Software Limits: Mot Active Actual Motor Position v - mem
& Motor Phase: OK

Error Log > .
¥ Motion Abort Input:  Not Active Mode: Position, Programmed

CYM Control Program:  Not Running
¥ Home: Referenced e
 CAN Status: oK e
Fault: Following Error Velocity 20 mmfs
{l 2
Control Acceleration 4800 mm/s
Enable | Set Zero Position Deceleration 4800 mmfs?
Disable r Fa Reset [V Enable Jog Move NEG | Maove POS l

Close

Figure 28, CME2 error

* Press Close and quit the CME2
» Start GeoDAS = Tools - Multifunctional Tester to start your simulations

'UZ? When stopping the simulation for more than 3 minutes, switch off the Shaking Table with the
Emergency Stop Button to avoid any overheating of the linear motor.
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5. Make your own Script

In GeoDAS it's possible to make fully customised user scripts and save/reload them easily to/from a file.

i<

controller will not be initialised and no movement will be executed.

Test Command
Command 917
Options

Channel

i, mm

[z

ChannelfFile |File
-10.

Il Multifunctional Tester

Shaker: Start PYT Move

=

Set Timeout
Shaker: Enable Debug
Shaker: Generate Sweep

Shaker: Get Acceleration
Shaker: Get Deceleration
Shaker: Get Homing

Shaker: Get Abort Deceleration

Shaker: Get Jerk
Shaker: Get Moving Home:

Message or a com

Insert |

| Signal Parameters. .. |

Run all | Reset | Stop Shaker l Quit |

It’s important that the first command is always the Shaker: Initialise command, otherwise the

To build your own script, select a command in the box, for example Shaker: Initialise

1S[=1 E3

Command [p1 ] P2 [ p3 [ Pa [PSMess... [R..]] comment

Figure 29, Empty Multifunctional Tester

are needed.
Press Insert

Il Multifunctional Tester

Test Command

Command 900 [shaker: Initialise =l
Options
Channel 1 CAN Port: ixxat0
BitRate  [S00 kbit/s =]

Xmin, mm [ rnax, mm [ 1

Message or a comment:

I §topShaker|

Run All

Reset Quit

If required, the settings can now be adjusted. For the Shaker: Initialise command no adjustments

=1 B3

Command [P P2 [ p3 [ P4 [Ps(Mess.. [R..]] comment

@ shaker: Initialise 1 ixxat0 500 ...

Figure 30, Building a script

The command is now inserted in the main window.

Now add any other commands

from the list described in chapter 5.1 and press Insert

If you want to change an already inserted command, please do the following steps:

Press Update

Select the command in the main window, its parameters will appear on the left side
Change the parameters as required

It's possible to insert as many commands as wish. As soon you are finished, there are two ways how to run

the commands on the shaker
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1. Run all the commands together by pressing Run all
2. Run a single command by right click on the command and then Run Commands, only the selected
commands will be executed.

I Multifunctional Tester =1
Test Command
Command [ [ P | P3 [ P4 [PS(Message) [ [l [ |
Command 905 [shaker: Move =l Shaker: Initialise 1 poatd 500 Kbitfs
, @ Shaker: Set Moving Home 1 4600 50 100
Options. Shaker: Set Homing 1 20 1] 800  Hardstop Negative
it L dohaker: [Mquand 7 p.0 Absolute
Channel 1 Position, mm 0.0 Insert From File
Move type  [Absolute =l 2ave to File
Save as Macro
Yslow, mmjs | Vfast, mmjs |
cut Chrl+x
i - o Insefted commands
Delete Del
Select all Ctrl+a
Hide Controls
Pardmeters wate | |
Runall | Reset | stopShaker | Quit |
Runfa single command

Figure 31, Running a script

5.1. Shaker Commands

&~ | All the commands suitable for the shaker start with “Shaker:”

5.1.1. Initialisation

Initialise

This command initialises the shaker. It must be run after every restart. If this initialisation has not been done,
there will be an error.

Channel This is the channel used to communicate with the shaker (default is 1)

CAN port: If the shaker is being steered with the provided USB-to-CAN compact converter from
IXXAT, the CAN port must be ixxat0

Bit Rate: Bit rate used to communicate with the shaker. The default Bit rate is 500 kBit/s.

5.1.2. Commands to Shaking Table

Generate Sweep

This function generates a sweep which can be used in three modes:

* Constant Acceleration
* Constant Displacement
* Constant Velocity

The following parameters stay always the same, independent from the mode which is selected:

Duration,sec: The duration of the sweep in seconds. The duration must be in the range of 1 to 255
seconds.

Fstart,Hz: Start frequency.

Fend,Hz: End frequency

The following parameters change, depending on the selected constant parameter.
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Constant: Acceleration — The shakers keeps the acceleration constant during the sweep.

A,mg: This is the acceleration of the sweep in mg. The acceleration will be kept constant even if
the frequency is changing.

Constant: Displacement — The shakers keeps the amplitude constant during the sweep.

X,mm: This is the displacement of the shaking in positive and negative direction. The parameter
must be in the range of your shaking table, otherwise the slide will crash in to the sides.

Constant: Velocity — The shakers keeps the velocity constant during the sweep.

V,mm/s: This is the velocity of the sweep.

U&~ |If the start frequency is not the same as the end frequency, the linear motor makes some noise.
This is a mechanical behaviour and should be kept at a minimum.

Move

With this command the shaker can be set to a certain position or the home position (zero point) can be set.

Move type:

Channel:

Position,mm:

Example:

-330 mm

Absolute — This command is used to set the shaker to a certain position. The value in the
position box is the distance from the home point (zero point).

This is the channel used to communicate with the shaker (default is 1)

The position in mm. The value can be positive or negative and must be in range of your
shaker.

The home position is set to the middle and the shaker has en offset of -150 mm from the
home point. Now the shaker gets the order to move absolute 50 mm. The shaker will move
200 mm in the positive direction, to the absolute point +50 mm

Shakercurrent pos. Home Shaker new pos. +330 mm
50 mm

Move type:

Channel:

Position,mm:

Example:

-330 mm
|

I
50 mm —>|
200 mm
Figure 32, Moving “Absolute”
Relative — This command is used to move the shaker over a certain distance from the
actual position. The value in the position box says which distance the shaker moves.

This is the channel used to communicate with the shaker (default is 1)

The distance to the new position in mm. The value can be positive or negative and must
be in range of your shaker. The shaker will move this distance from the actual position.

The shaker gets the order to drive relative 200 mm.

Shakercurrent pos. Shaker new pos. +330 mm
50 mm

- =

Figure 33, moving relative
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Move,type: Home - This command is used to set the home point of the shaker. Normally the home
point is set to the middle, but for example it can also be set to 200 mm offset to the
negative side. To do this, the commands “Shaker: Set Homing” and “Shaker: Set moving
home” are needed. These two commands are used to set the parameters of the homing

command.
Channel: This is the channel used to communicate with the shaker (default is 1)
Position,mm: This is the offset the home point should have from the side plate
Example: The position,mm is 200 mm and the mode is negative, the Shaking table will now move to

the very outside. And will then drive 200 mm in the positive direction. This point is now the
zero point for the shaker.

Shaler new pos. and i ]
-330 mm new home position Middle point +330 mm

- o ]

Figure 34, Moving home

Reset

This reset command is to use in case of an error. It will immediately reset all the errors and faults.

Channel: This is the channel used to communicate with the shaker (default is 1)

Set Abort Deceleration

This command sets the abort deceleration of the shaker.
Channel: This is the channel used to communicate with the shaker (default is 1)

A,mm/s’2: This is the acceleration when the shaker stops in case of an abort.

Set Amplifier’s State

Sets the state of the shaker, you can choose between Enable, Disable and Reset.

Set Acceleration

This command sets the maximum acceleration of the shaker.

Channel: This is the channel used to communicate with the shaker (default is 1)
A,mm/sh2: This is the maximum acceleration when the shaker starts moving. (default is 45000
mm/s*2)

Set Deceleration

This command sets the maximum deceleration of the shaker.
Channel: This is the channel used to communicate with the shaker (default is 1)

A,mm/sh2: This is the maximum acceleration when the shaker stops. (default is 456000 mm/s*2)
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Set Velocity

This command sets the maximum velocity of the shaker.

Channel: This is the channel used to communicate with the shaker (default is 1)

V,mm/s: Maximum velocity of the shaker (default is 2000 mm/s)

Set Homing

This command initialises the way how to find the home position.

Channel: This is the channel used to communicate with the shaker (default is 1)

Offset,mm: This is the offset to the sidewall.

Method: This box says on which side the shaker should drive

Delay: The delay to drive back from the very outside

Imax,mA When the shaker drives to the very outside he presses against the side plate, this makes

the current rising. As soon as the here given value has been reached, the shaker stops
(default is 1600 mA)

Set Moving Home

This command sets the velocity of the shaker for the homing process

Channel: This is the channel used to communicate with the shaker (default is 1)
A,mm/s’2: This is the maximum acceleration of the shaker

Vslow,mmy/s: This is the speed of the shaker while moving to the outside (default is 50 mm/s)
Vfast,mm/s: This is the speed of the shaker while moving to the given position

(default is 100 mm/s)

mm/s*2 and Imax is 1600 mA, the shaker will reach the current limit with the acceleration and
will then move right in to the positive direction without first going to the negative side, so it will

I&~ |As higher the acceleration is as higher is the current. If the acceleration for example is 4500
crash in to the side plate. So for example a good value are A: 400 mm/s*2 and Imax: 1600 mA.

Set Sweep Sampling

This command sets the SPS (samples per second) of the sweep process
Channel: This is the channel used to communicate with the shaker (default is 1)

SPS: Samples per second

Start PVT Move

This command reads the data of a file and simulates it. The file must be in a GeoDAS format, an example for
such a file is stored on the provided GeoSIG CD, filename “Example_Earthquake.ixt”.

Channel: This is the channel used to communicate with the shaker (default is 1)

Filename: The filename of the file that should be simulated. File must be saved under
C:\GeoDAS_DATA\Tester\Output

Xmin,mm: The relative minimum the shaker can drive (default is -330 mm)

Xmax,mm: The relative maximum the shaker can drive(default is 330 mm)
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Stop PVT Move

This command stops the PVT move.

Enable Debug

This function creates a log file on the selected path. GeoDAS will write all the errors and warnings which
were produced in the selected log file.

Logfile: In this box the path of the log file should be written.

Get Jerk

This command reads the jerk. It will be displayed in the column Value

Channel The channel used to communicate with the shaker (default is 1)

5.1.3. Read Data from the Shaking Table

Shaker: Get Abort deceleration

This command reads the deceleration in case of an abort. It will be displayed in the column P2

Channel The channel used to communicate with the shaker (default is 1)

Shaker: Get Acceleration

This command reads the acceleration limitation. It will be displayed in the column Value

Channel The channel used to communicate with the shaker (default is 1)

Shaker: Get Deceleration

This command reads the deceleration limitation. It will be displayed in the column Value

Channel The channel used to communicate with the shaker (default is 1)

Shaker: Get Homing

This command reads the following homing data: method offset, delay and Imax. They will be displayed in the
column Comment

Channel The channel used to communicate with the shaker (default is 1)

Get Moving Home

This command reads the following homing data: Acceleration, Vslow and Vfast. They will be displayed in the
column Comment

Channel The channel used to communicate with the shaker (default is 1)

Get Velocity

This command reads the velocity limitation. It will be displayed in the column Value

Channel The channel used to communicate with the shaker (default is 1)
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6. Errors and Troubleshooting

6.1. Error and Warnings

The shaker has some thresholds which we can set. For example if the true position is not the same as the
commanded position (Following Error). The Shaking Table will stop immediately when a warning/error
occurs. The type of the warning will be displayed in the Multifunctional Tester from GeoDAS when running a
script, or directly in the CME2 Software. To delete the warning one of the two following steps can be done:

1. Press the Emergency Button and release again, or
2. Clear the warning/error in the CME2 by the following steps.

* Close GeoDAS and open the program CME2
* Click on the symbol Control panel

i i

File Amplifier Tools Help ) )
LO«ul EEIEEE L

(=} _§ Copley Neighborhood CAN Network:  Address: 1 State: Operational
1 viual Amplifier

1*~~BCAN1: unnamed Input / Output

CVM Control Program |

_I_l

CAN Configuration l—o P Loop I—Q Y Loop | Loop Motor/Feedback |
3

Home Configure Regen Configure Faults |

Sine Commutation {Lineaf Mator [Aﬁ\p Under CAN Control { F12 To Disable

Figure 35, CME2 error

* Press Clear Faults then the warnings should become green

RISk
Status Warnlings
@ Motar Output; Not Active R Zl - A
@ # Hardware Enabled:  Enabled
# Software Enabled: Enabled IActual Motor Velodity LJ _ T
& Positive Limit: Mot Active
! 2 Negative Limit: Mot Active
i Software Limits: Nat Active I"Ct'ﬂ‘ Motor Position L] - mm
& Motor Phase: OK
¥ Motion Abort Input:  Not Active Mode: Position, Programmed
CYM Control Program:  Not Running
¥ Home: Referenced
 CAN Status: oK fove
Fault: Following Error ety 20 (e
Cockrol Acceleration 4800 mmjs?

Deceleration 4800 mm/s?
Reset [V Enable Jog Move NEG | Move POS l

Close

Enable
Disable

Figure 36, CME2 error
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6.2. Wrong Driver for the USB-to-CAN Converter

In case you connected the USB-to-CAN Converter before you installed the drivers it might be that Windows
installs a wrong driver. Please do the following steps to change the driver:

* Press right click on the My Computer icon on your desktop

* Press Manage

Open

Browse with Paint Shop Pro 2
Command Prompt Here
Explore

Map Network Drive...
Disconnect Network Drive...

Create Shortcut
Delete
Rename

Properties

Figure 37, Right click on My Computer

The Computer Management window will now open

» Select Device Manager

* Press the small + on IXXAT VCI V3 Interfaces to see the details
* Right click on VCI3 USB-to-CAN compact

* Press Properties

_loix
=) File Action View ‘Window Help =151 x]
e | AR FE 2 A =R
1% Computer Management {Local) = _Q) LAPODG =
=) ﬂ System Tools 3] Q Batteries
(4] Event Viewer [+ ¢ Computer
- Shared Folders [+] “2e» Disk drives
[+ g Local Users and Groups [+] } Display adapters
+ @4 Pe ance Loas and Alerts [+ ., DYD/CD-ROM drives
4._% [+ (&5 Human Interface Devices
-l y Storage [+ IDE ATA/ATAPI controllers
+ g3 Removable Storage [+] & IEEE 1394 Bus host controllers
g Disk Defragmenter [= @XXAT YCI V3 Interfaces
+ ‘ Q'SK Managem‘entl o = Update Driver, .,
CR: _9 Services and Applications [+]- Keyl
@7 Mice Disable
- B Mod Uninstall
": .i x°t" Scan for hardware changes
[+ ity
(¥  Ports (COM & [P
[+ %9 Processors
@, Sound, video and game controllers il
3] System devices
< | L] [ 4{0 Universal Serial Bus controllers L]
\Opens property sheet For the current selection, |

Figure 38, Computer Management
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» Select the Driver tab
* Press Update Driver...

21x|
Eg VCI3 USB-to-CAN compact
Driver Provider.  [XXAT Automation GmbH
Driver Date: 2141172007
Driver Version: 1.20.1784
Digital Signer: Not digitally signed
Driver Details... | To view details about the driver files.
e —
‘ Update Driver... To update the diver for this device.
———
. If the device fails after updating the driver, roll
RolBack Divét |  back to the previousy installed diver.
Uninstall | To uninstall the driver (Advanced).
oKk | Concel

Figure 39, Change driver

A Hardware Update Wizard Window will open

e Select No, not this time
* Press Next >

Hardware Update Wizard

Welcome to the Hardware Update

“}Q\ wizard

Windows will search for current and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update Web site (with your permission).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

" Yes, this time only

" Yes powand every time | connect a device

Click Nexst to continue.

H ar H Next > I )Cancel |

Figure 40, Update of driver
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* Select Install from a list or specified location (Advanced)
* Press Next >

Hardware Update Wizard

This wizard helps you install software for:

VI3 USE-to-CAN compact

* ) If your hardware came with an installation CD
~a~ or floppy disk. insert it now.

What do you want the wizard to do?

" Install the software automatically [Recommended)
@Install from a st or specific location [Advanced] >

Click Nest to continue.

< Back (\ Iﬂext>) Cancel l

Figure 41, Update of driver

e Select Don’t search. I will choose the driver to install
* Press Next >

{Hardware Update Wizard 7

Please choose your search and installation options. \\

>,

" Search for the best driver in these locations.

Use the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

™ Include this location in the search

@n’tseerch. | will choose the driver to instD

Choose this option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

<Back( Nest > ) Cancel I

Figure 42, Update of driver
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* Select the IXXAT USB-to-CAN compact
* Press Next

Hardware Update Wizard 1 B

Select the device driver you want to install for this hardware. §\

N,

B Select the manufacturer and model of your hardware device and then click Next. If you
have a disk that contains the driver you want to install, click Have Disk.

[V Show compatible hardware

Model
EX<AT USB-to-CAN compact

VCI3 USB-to-CAN compact

8\ This driver is not digitally signed! Have Disk... |
Tell me why driver signing is important

< Back Next > ) Cancel |

Figure 43, Update of driver

* Press Finish, then close the window and restart your computer

Hardware Update Wizard

Completing the Hardware Update

i:Q\ Wizard

The wizard has finished installing the software for:

Erf“i [XXAT USB-to-CAN compact

Chick Finish to close the wizard.

(=)

——
Figure 44, Update of driver
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6.3. Shaking Table is not initialised

If the initialisation of the Shaking Table doesn’t work, please check the points listed below:
I =1o1x|

] P1 I P2 ] P23 i IPS {Message) | Result l Value lComment |

xxatd 500 kBit/s ERROR Unexpected result: empty string

Figure 45, Failed initialisation of Shaking Table

6.3.1. Is the Shaking Table powered?

- Have a look at the Xenus Controller, the Status LED should blink.

6.3.2. Is the USB to CAN converter attached to your computer and the Xenus controller?

- If not, attach the USB-to-CAN converter

6.3.3. Are the correct driver installed?

If you have not installed all drivers, please install them now (see chapter 2.1 and 2.2). Check the driver
version by following the explanation in chapter 6.2.

6.3.4. Have you restarted your computer after you’ve installed the drivers?

If not, restart your computer, so that the driver works properly
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7. Restore Factory Settings

Open the CME2 Software

Press the button Restore amplifier Data from Disk

S CME2 V5.0 (XSL-230-18 unnamed) -
File Amplifier Tools Help

_[ol x|
S—
2 awn| R rr
& 2 B (Gl
-
[=}+ _§ Copley Neighborhood CAN Metwork:  Address: 1 State: Operational
- KB Virtual Amplifier
- —-BCAN1T: unnamed Input/ Output |
CWM Contro] Program Il | |
CAN Configuration l—b P Loop L—’ M Loop l—b 1 Loop I—O MotorFeedback I
Figure 46, Factory Default
L]

Brows the provided GeoSIG CD and open the file GeoSIG_Standard_AmpData.ccx

@ Restore amplifier Data from Disk

Look in: I.Q AmplifierData_Backup

x| 2 0EE
Geosig_Standard_AmpData. cox:

x|

Figure 47, Factory Default

Press the button save amplifier working data to flash
@cre2 vs0 (5123018 wnamed)
File Amplifier Tools Help P

A7 @ OV [ B o el
[=}"_§ Copley Neighborhood

CAN Network:  Address:
8 vitual Amplifier
L*~-WCAN1: unnamed

1

State: Operational
Input / Output

CWM Contro] Program

CAN Configuration I—Q P Loop Vioop 1Loop

Figure 48, Factory Default

MotorFeedback

£ | Always perform a Homing of the Shaking Table after the amplifier data has been loaded
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8. Maintenance

Even if the Shaking Table is almost maintenance free there are some points to be taken care, especially if
the Shaking Table has not been used for a long time.

8.1. Cleaning

The Shaking Table should be held clean of dust any other dirt. Especially all parts related to the linear motor
and its feedback sensor:

¢ The magnet
* The motor rail
* The measuring scale of the feedback sensor

»

s oL E R N

.

suring Scale

Figure 49, linear motor

&~ | Use mild soap only! Do NOT use any Alcohol, Acetone or similar products as this damages the
measuring scale of the feedback sensor.

8.2. Grease the moving Parts
Because the sliding carriage is permanently moving on the motor rail, these parts should be greased every

six month. For this two lubricating nipple are installed on both side of the linear motor. Use these nipples
only, do not put oil directly on the motor rail.

Figure 50, Lubricating nipples
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8.3. Check of the Feedback Sensor

The feedback sensor should be checked every six month. There is a LED on the top of the feedback sensor
which can have three states:

Green: Everything is okay
Orange: It's probably working but it's not perfect
Red: It's no more working

If the LED is orange or red, the sensor must be adjusted according to the instruction in the manual
Sensor_Installation_Guide.pdf (Page 4), found in the folder Manuals_And_Guides on the provided CD.

L
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